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o3 Introduction

In keeping our commitment to support our National Offices, Seiko Hong Kong Ltd has created
an interactive advertising and promotion planning resource for our valued partners.

This user guide will show you how to access our full complement of images and materials for
Pulsar, Lorus and Alba.

This system provides unprecedented control of (ad planning) and production, including:

e Self-service, online access to the Image Library, Logos, Retail Planner Materials,
POS, GWP & Box Catalogues, Operational Guides and much more

e Options to view, download to your PC in EPS or JPG formats. No special graphics
or computer skills are required to access or transfer images

e Easy navigation
e Fast delivery to publications, agencies, cable stations or websites
e Support for all advertising and point-of-sale initiatives

e Reduced time to market

3 SEIKO Hong Kong Ltd.



EIKO Hong Kong Ltd. - Microsoft Internet Explorer

LORUS

DUGINFONHERS TS TEM)

In Keeping our commitment to support our Mational Offices, Pulsar-Alba-
Lorus have created an interactive marketing planning resources for our
valued partners.

Login: |

Password: |

Forgot your User ID or Password? Please contact to
Pulsar, Alba & Lorus Division, SEIKO Hong Kong
Limited.

To view a Tutorial of this site Click Here.

Copyright@2005, SEIKS Hong Kang Lid.

1. Enter login name in the “Login” field.
2. Enter password in the “Password” field.
3. Click “Submit” button to log on the site.

Note: If you forget your user ID or password, please contact Pulsar, Alba & Lorus Division, SEIKO

Hong Kong Limited.
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o3 Navigation

2} SEIKO Hong Kong Ltd. - Microsoft Internet Explorer B ]

PULSAR

it's all in the details

|+

Admin Pages Pulsar » Lorus + Alba To view a Tutorial of this site click here

Home
Who We Are & History
Pulsar Today’ Mission

Selling Features of Pulsar
Ower Competition

Selling Features of Pulsar
Watch

Communication
Best Proposed Assortment »
Image Library *»

m

Logos * wWants 8ix ch:ld?m
Manufacturer’s Brand Laoves butterscoteh pudding

5 BtilLum“a Mjﬂ 3 £ { Jrammpron sande
Brand Essence Film ’H“%h o planis 53 5 \ ’ [THOY Yy PR .L;H.-_ v

- GArAa - I P

YMD {(Visual Merchandisin, Tulsar. 4% | _ B ‘E.__.m o [liar:
Catalogue * S ¥ T
Glossary of Watches = puisaz & : !
Care of Watches
Band Sizing
Calibre Information
Operating Manual
Download Area
List of Distributors
Service Network pU LS AR
Extranet
T =

0 Left menu navigation bar
e  Enables you to access any section of the site.

e Top menu navigation bar
° Enables vou to access anv brand site such as “Pulsar. Lorus and Alba“.
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3 Image Library

Let “Image Library” as an example. If you roll over the “Image Library” text, you can make a
selection from dropping down the menu. In this case, the dropped down menu includes:

PRESTIGE
POISE
PERFORMANCE

PRELUDE

=101

PULSAR

it’s all in the details

Admin Pages Pulsar « Lorus » Alba To view a Tutorial of this site click here
Home

Who We are & History
Pulsar Today! Mission

Selling Features of Pulsar
Ower Competition

Selling Features of Pulsar
Watch

Communication
Best Proposed Assortment &,
Image Library *

PRESTIGE *

Belicie
Logos * POISE »  does varve gt O i
Manufacturer’s Brand PERFORMANCE *» f.dlcs Sos s oifg,

[ hrampron s
q...\.f'..tr{.w.x\ Doy seren

ornmer vegan
Wiarrs ot Phafir

Brand Essence Film
VYMD (Visual Merchandising)
Catalogue *» e
Glossary of Watches — -

Care of Watches N
Band Sizing

Calibre Information

Operating Manual

Download Area

List of Distributors

Service Network pU LSAR

Extranet

El
\Adatnn

R
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3

Example
23 SEIKO Hong Kong Ltd. -

Microsoft Internet Explorer

Image Library (cont.)

=101

PULSAR

it’s all in the details

Admin Pages

Home
Who We Are & History
Pulsar Today' Mission

Selling Features of Pulsar
Owver Competition

Selling Features of Pulsar
Watch

Communication

Image Library *
Logos *»
Manufacturer's Brand
Brand Essence Film

Catalogue *
Glossary of Watches
Care of Watches
Band Sizing

Calibre Information
Operating Manual
Download Area

List of Distributors
Service Network
Extranet

LT R

Best Proposed Assortment *

YMD Misual Merchandising)

Pulsar = Lorus - Alba

To view a Tutorial of this site click here

CHRONOGRAPH

(BRACELET & STRAP)

GENTS 50M WH
vn.'ar' (BRACELET & STRAP)

uls
GENTS BRACELET
GENTS STRAP
________...----"" MECHANICAL

LADIES 100M WR
(BRACELET & STRAP)

LADIES 50M WR
(BRACELET & STRAP)

LADIES BRACELET
LADIES STRAP
EXCLUSIVE MODELS
NURSE WATCHES

PERFORMANCE *
PRELUDE *

y g - —

[ foas e €
ks .\-\ NI

( Jramprion s o

P ey

[ormmer vagant

\X et ot Pk

PULSAR

PULSAR

| v

1. Roll over “Image Library”, choose “PRESTIGE” and then click “CHRONOGRAPH”.
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o3 Image Library (cont.)

it's all in the details

Audmin Pagas Pulsar = Lorus » Alha Toview a Tutorial of this site chick here

Sefling Features of Pulsar  Print This Page = Print All = Setup Details = Atvanced Search
Over Compeetition Read Print Instructions

Selling Fealures of Pulsar Page 2 of 11

ol Chck on the model information and download options,
Communication

Best Proposed Assortmend =

Image Library *

Logos =

Manufacturer’s Hrand

Brand Essence Film

WMID (Visual Merchandising)

Catalogue *

Glossary of Watches

Care of Watches

| Bl Siring 7TE2 S5 ME2 =5

Calibare Information o] 55

Operating Manual W 5B oL WC 58 oL
P24 [ PIOCER

Dovenload Ares 100M PRE o 4 100M PRE o 4

List of Distributors SS00SES4107 34 A009E541 0741

Sendce Network

Extranet

il

PFI2S1X1 PFI253%1

0 Click “Print This Page* to print the current page.

Click “Print All* to print all products information in the current category.
Click “Setup Details" to configure the product details.

You can search the products by clicking “Advanced Search”

Click “Read Print Instructions” to read print instructions.

Shows how many total pages are there and what page you are at.

Click “Previous” to back to the previous page and Click “Next” to go to the next page.
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3 |Image Library (cont.)

2} SEIED Hong Kong Ltd, - Microsoft Internet Explorer

=101 x|
i
Band Stzing 7162 55 7TE2 55
Calibre Information 55 55
Operating Manual L= 8 LB e
Domdand PZO24X G PZOZ5X
Aree. 1008 PRE o 4 1008 PRE [
List of Disributors A0S 1 07 34 4005341 0741
Edit | Details
PFI272%1 PFIZE1%1 PFI315%1 =l

e Click the picture for details of the product.

e Information of the product.

@ Click “Edit" to insert data in the “DF* field.

@ Click “Details* to view the details of the abbreviation.
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3 Image Library (cont.)

Setup Details

:iﬁ!l 1ED Hong Kong Lbd, - Micr ternet Explorer B! _._IEIﬁI
: Al
it's all in the details
Aubmin Pages Pulsar + Lomus = Alba Toview a Tutorial of this site click here
Hormne i
Who We Are & History Image Library
Putsar Today! Mission PRESTIGE - CHRONOGELFH
Selling Features of Pulsar  Prist This Page « Print All mmsw:h
Owver Competition Read Print Instructions
mmum Page 2 of 11 Previous | Nesd
Clck on the image for model information and download options.,
Communication
PFI253%1
7Te2 55
£z
W S8 e
PIO25H (7]
1008 PRE o 4
42000410741
=

Click “Setup Details “in the above.
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3

Image Library (cont.)

The Setup Details page provides to allow users to select show/hide the fields in feature table.

TTE

1008
4200

I

3

3

3

3

3

3

3

3

(3

I Y Y B (Y B IS Y B

(3

Cal Code

Case Material

DF1

Case Code

Bezel

Crown

Glass Code

Case Back

Band Material

Band Construction

Band Clasp

Save

| Cancel |

¥ Band Code
¥ Gender

¥ ‘wyater Resistance
¥ Category
¥ Role

¥ Lead Time
¥ Ean Code
¥ DFz2

¥ std. FoB
W DF3

¥ Remark

the details

wtorial of this site click here

Copyright@2005, SEIKO Hong Kong Lid,

PRAEN

;Qg

]

M PRE
rnswasm
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3

Advanced Search

Image Library (cont.)

a SEIKO Hong Kong Ltd. - Microsoft Internet Explorer ;lglil
Admin Pages Pulsar + Lorus » Alba To view a Tutorial of this site click here [ |
Home
Who We are & History Advanced Search
Pulsar Today! Mission
Selling Features of Pulsar Select your search criteria helow then click the Search button ° Back
Ower Competition
Selling Features of Pulsar Model Noz: I Favorites
Watch
—— . 1. test
Communication Price Range: I to 7
2. test?
Best Proposed Assortment *
Image Library * Select the Search Field: 7 3. tests
Logos * I j = I j Ey 4. 66
Manufacturer's Brand |OR J I J _ I J & 5. Mone
Brand Essence Film E? 5. Mone
VMD (Visual Merchandising) I OR ﬂ I ﬂ = I ﬂ i 7
Catalogue * | orR = | B - I Hl & 5 Mane
Glossary of Watches
Care of Watches IOR j I j B I j E? ko Mone
Band Sizing for =] | = o= = 37 10. None
Calihre-lnfurmatiun I OR | I = - I = &7 1. Mane
Operating Manual on J J J [F 12. More
Download Area I I ) I 7 13. 1
. Mone
List of Distributors for =] | o= =l 07 14. Nome
Service Network I OR j I j = | j :
prpeery & 15. More
Ml Search | Reset | Sawe Search Criteria
Change Password
Help »
Copyright@2005, SEIKC Hong Kong Lid, _I

You can search products by the following criteria:
Model No# , Price Range , Select the Search Field , Favorites.

o Click “Search* to search products.
e Click “Reset" to reset the criteria.
e Click “Save Search Criteria“ to save the current search criteria.

° Click “Back" to back to the previous page.

e In the “Favorite” menu, click [¥to edit “Search Criteria®.

e Click the name of “Search Criteria“ to search products with saved criteria.
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3

Image Library (cont.)

1. When click “Save Search Criteria“ as below, you can open the “Favorites List".
2. And then save the search “Criteria“ into “Favorites*.

3 SEIKO Hong Kong Ltd. - Microsoft Internet Explorer

Admin Pages

Home

Who We fre & History
Pulsar Today’ Mission

Selling Features of Pulsar
Ower Competition

Selling Features of Pulsar
\Watch

Communication

Best Proposed Assortment
Image Library *»

Logos *

Manufacturer's Brand
Brand Essence Film

YMD (Visual Merchandising
Catalogue *

Glossary of Watches

Care of Watches

Band Sizing

Calibre Information
Operating Manual
Download Area

List of Distributors

Service Network

Extranet

Pulsar « Lorus « Alba

=101

To view a Tutorial of this site click here

o ] [
Back
] ) Favorites
g 1ollowing and key in the Mame you want to save. E?
1. test
Hame [ 2 test2
(O Itest Water Resistance = 1000 Or Band [ 3. tests
Material = PL Or CAL Code ="hhh" Or i
Categary = PER Or Rale = GO 4 66
€7 [restz Price == 1000 and Price <= 299 & 5 hone

6. Mone

3 ItestS Water Resistance = 100M Or Band E?
Material = P Or GAL Gode = "hhh" Or B7 7. More
Category = PER Or Role = GO —| |Z 8. Mone
4 IBB Water Resistance = 100M Or Band 9. Mone
Material = PU Or CAL Code = "hhh" Or 7 10. Nore
Category= PER OrRole = CO E?

11. Mone
cs I ¥ 12. More
Ci I [F 13. More
o7 I &7 14. Mare
q = [3 15. More

Website
Change Password
Help *

—
= |E@ar®

Copyright@®2005, SEIKC Hong Keong Lid,

|
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o3 Print Instructions

The “Read Print Instructions” provides “Print All“ and “Print This Page" instructions.

Print All

Image Library

PRESTIGE - CHRONOGRAFPH
Print This Page (P Setup Details = Advanced Search
Rad Prind Instructi s

Page 1of 11 Hext
Click on the image for model information and download oplions.

= = 1:.|‘I

4200969405143

1. On the screen above, press “Print All“.

Internet Explorer - Security Warning ﬂ

Do you want to install this software?

Mame: MeadCo's Scripks
Publisher: Mead & Company Limited

= Always install software from "Mead & Companry Limited"

™ Mever install software From "Mead & Compary Limiked"

% ask me every time

Fewer options Install | on't Install

O —
‘While Files from the Internet can be useful, this file type can potentially harm

your compuker, Only install software From publishers you trust, What's the risk?

2. User would be warned about installing “MeadCo’s ScriptX* plug-in. Press “Install“ to
continue printing procedure.
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o3 Print Instructions

Print All

SEIED Hong Eong Lid. - Microsolt Internet Explorer

(cont.)

Fle Edt Yew Favortes Took  Hep

biew b b i _peinkall msp
Edit with Microsoft Office Word FH
Save BE...

Work Offine
Dase e i [ PRz [ “FRazasil
T |BE | |7 5% | L7 LTS
L L N N 7 SO i 1T 1 1 T
[ 566 [BL_ [ [WME_[ECH  [BL_ | ME [EE I ) WE [ [BL
(O < L.+ EF S - T . < [ O . - S [
[T [PRE V0|3 [FoM[FRE _TCO_ |4 |Wr [PRE__TCO |4 \WR [PRE_[CO |4
i_‘.'?'?";"!":‘!"—""“ || |SRKEORIEE [ W'HI_ | pEeEeviied L
. f i1
[ o (- AT T (=il

3. Then press “File > Print...“~or press “Ctrl + P“.

s
General I Dp[ignsl g
— Select Printer
-
o
Add Printer Micr osoft
% Office Doc...
H
Status: Ready [~ Piinttafile  Preferences |
Location:
Eeren Find Printer... |
— Page Range
Al Mumber of copies: |1 3:
") Selection € Curent Page
" Pages: |1 ¥ Collate E
Enter either a single page number or a single !
page range. Far example, 512

< Prink i> Cancel |

Apply

4. Select the right printer then press “Print“.

15
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o3 Print Instructions (cont.)

Print This Page

Image Library

IGE - CHRONOGRAPH

A

Page 2 of 11 Previous | Next
Click on the image for model information and download options.

PFR251%1
TT62 |55
55
MC  SCB GL
PID24X G
100M PRE Co 4
400963410734 4500569410741

1. On the screen above press “Print This Page”.

16 SEIKO Hong Kong Ltd.



o3 Print Instructions (cont.)

Print This Page

3 SEIKO Hong Kong Ltd. - Microsoft Internet Explorer
fle Edt View Favorites Tooks Help

Bewr b bt il_printors. stpocpage=z

Edit with Micrasoft Office Word FH

Save As...

Sand *

Imgort and Export...

Properties

Work Offine

Closs PFIZTEN [
[7Te2 |55 TI62 |55 [ 7162 [T [
|55 | SEGP [ | (2T [
(e | 55w =1 L mc [ece (1B |so
GIETET |3 PR R4S 5 [PR [PCagax G
[100M [PRE oo |4 [100e |PRE [co 4 [100m [FReE [co [4
(450056541 3560 [ 4S00REINFETT [ SEO0BEA411557

| | | | |
| |
2. Then press “File > Print..." or press “Ctrl + P“.

[;=
i &
General I Dptlonsl
r— Select Printer
=
E
Status:  Reads [” Printtafile  Preferences |
Location:
Comment: Find Printer. .. |
—Page Range

Lo | Mumber of copies: |1 3:

€ Selection & Curent Page

= Pages: |1 ¥ Collate E
Enter either a single page number or a single

page range. For example, 512
Cancel I Apply I

3. Select the right printer then press “Print".
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o5 Detall Page

The “Detail Page” provides all information about the product as well as features.

1. Click the image as shown below.
2} SEIED Hong Kong Lbd, - Microsoft Internet Explorer g = DI!I

PULSAR 1
it's all in the details
Pulsar = Lorus « Albha Toview a Tutorial of this site click here
Image Library
PRESTIGE - CHRONOGRAFPH
Priot This Page = Print All = Setup Details = Advanced Search
Read Print Instructions
Page 2 of 11 Previous | Next
Click on the image for model information and download options.
WMD (Visual Merchandising)
Catalogue *
Glssary of Watches
Care of Wiatches
PFI251%1
| USRS 7762 55
Cadibre Information g
Operating Manual MC 308 GL
PIOR4K &
Dowendoad Area 100M PRE oo F
List of Distributors 4200253410734
Service Network
Extranet
Websile =l

18 SEIKO Hong Kong Ltd.




o3 Detail Page (cont.)

it's all in the details

Who W Are & History Image Library

Pulsar Today! Mission PRESTIGE - CHRONOGRAPH

Selling Features of Pulsar wnmmo Click image to Enlarge
Onver Competition

Sefling Features of Pulsar
Walch

Communication

Best Proposed Assortment » mg““'“‘m’“”
Imape Library = Phuto JPG Mo
Logos =

Manufacturer*s Brand

Brand Essence Film

WD (visual Merchandising)

Catalogue *

Glossary of Watches

Care of Watches

| Band Sizing

Calibre Information

Operating Manual

Dowadload Area

List of Distributors

Service Netwark

Exctranet

S o

Audmin Pagas Pulsar « Lorus « Alha Toview a Tutorial of this site clck here

Click “Print This Page”.
To “Print“, click “File” and then “Print”.

e Click “Back” to back to the previous page.
e Download images of EPS, JPG format.

° Click the image for enlarging.

e Information of the product.

19
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o3 Download

“Download” — Allows you to transfer a single selection at a time, directly to your computer.
Files that may be downloaded include:

IMAGES

LOGOS
MANUALS

1. Click “Download” and then you can choose “Open” or “Save” the file in “File Download”
window.

Fila Ul [3

b ] Some files can ham yvour computer, I the file information balow
-_-rnl" loiakes suspicious, oryou do nat fully trust the source, da not openar
save this file.
File name: SNLOO1,p=s
File type:

From seiko.dev.multi-ad.com

Would vou like to open the file or save it to your computer?

I Open | l Save J I Cancel ‘ I Mare Infa

Always ask before opening this type of file

2. Click “Open” to view the file.
-OR-
Click “Save” to save the file on your desktop or in other desired folders.

3. Like other files, double click “My Computer” and then locate your file. To open, please double
click your file.

20 SEIKO Hong Kong Ltd.



o3 Download PDF

You need Adobe Reader (version 4.0 or higher) to view these files. To download Adobe Reader,
please go to http://www.adobe.com.

=101

| v

PULSAR

it’s all in the details

Admin Pages Pulsar + Lorus + Alha To view a Tutorial of this site click here

Home
L]
Who We Are & History Manufacturer's Bra

Pulsar Today' Mission

Selling Features of Pulsar The Manufacturer's Brand will provide you the detials about the quality in
Ower Competition production of our products,

Selling Features of Pulsar
Watch

Communication Please click below file to see the details.

Best Proposed Assortment =
Image Library * manufacturer’s brand1.pdf

Logos *»

Manufacturer's Brand 0
Brani Essence Film

YMD (Visual Merchandising)
Catalogue *

Glossary of Watches

Care of Watches

Band Sizing

Calibre Information
Operating Manual
Download Area

List of Distributors

Service Network

Extranet

T =
c Click “Manufacturer's Brand”.

e Click “manufacture’s brand1.pdf” to download the “PDF document*.

21 SEIKO Hong Kong Ltd.




o3 Download PDF (cont.)

B ]
it’s all in the details
Admin Pages Pulsar » Lorus » Alba To view a Tutorial of this site click here
Home N
Who We Are & History perating Manual
Pulsar Today’ Mission

Please select the required manual using the drop down box above. The manual is
Selling Features of Pulsar identified by the Calibre Mo.

EREIRCOME i You can find the Calibre No. on the back of your watch as shown:
Selling Features of Pulsar

Watch

Communication

Best Proposed Assortment *

Image Library *»

Logos *

Manufacturer's Brand

Brand Essence Film Calibre No.
YMD (visual Merchandising)

Catalogue *

Glossary of Watches Please choose a calibre no. |1aaa e
Care of Watches

Band Sizing Please select a language |Arahic j
Calibre Information

Operating Manual a Choose e .
Download Area
List of Distributors

Service Network
Extranet

e Click “Operating Manual”.

e Select “calibre no.” and “language” for manual.

e Then click “Choose” to download.
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o3 Download Video

=101

|»

PULSAR

it's all in the details

Admin Pages Pulsar » Lorus » Alba To view a Tutorial of this site click here
Home

Who We Are & History Bra Essence Film

Pulsar Today! Mission

Selling Features of Pulsar Mow the Pulsar Brand Essence Film is available for you to tell the Pulsar story to

Over Competition your retailers and consumers in the most powerful way ever. With this film, you
= can give them more impact and a more emotive explanation of this theme, The

Selling Features of Pulsar difference is in the detail',

Watch

Communication It is our belief that vou will make the best use of this film to present what Pulsar

Best Proposed Assortment stands far.

Image Library *»

Logos *

Please click below file to see the Pulsar Brand Essence Flim,

Manufacturer's Brand

Brand Essence Film 9 e
YMD (visual Merchandis PULSAR.wmy
Catalogue *

Glossary of Watches

Care of Watches

Band Sizing

Calibre Information

Operating Manual

Download Area

List of Distributors

Service Network

Extranet

e =l
c Choose “Brand Essence Film”.

e Click “PULSAR.wmv” to download the video file.

23 SEIKO Hong Kong Ltd.



o3 Catalogue

1. Click “Catalogue” and then Click “POS” as shown below.
23 SEIKO Hong Kong Lt crosoft Internet Explorer ) I =] [

PULSAR

it’s all in the details

| v

Admin Pages Pulsar + Lorus + Alha To view a Tutorial of this site click here
Home

wowesestison |
Pulsar Today' Mission

Selling Features of Pulsar
Owver Competition

Selling Features of Pulsar
Watch

Communication
Best Proposed Assortment »
Image Library *»

Ndilice
h'n'.:-'u\--f

Mot U..ur\-_g\.( bk
f n"i- 5 NS NS f":ﬁ .H
A donit Sappndeusile bnlilers
et otk Julg

OFIICT P

VMD (Misual Merchandising) i “r i Phalar
\ wtis af ks

Catalogue » POS -
Glossary of Watches BOX SAR ~f - PULSAR
are of Watches

Calibre Informat
Operating Manual
Download Area
List of Distributors

Service Network pU LSAR

Extranet

El
\Adatnn
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3 Catalogue (cont.)

/7§ SEIEQ Hong Kong Lbd, - Microsaft Internet Explorer

Catalogue
POS
re @
Click on the image for model information and download oplions.
PULSAR PULSAR |
PULSAR PULSAR »

P

Q Previous | Nest

PULEAR PULSAR FLLEAR - e
. LTET]

PULSAR

A R P A

Model Ho! PROP-03-08 . Hodel Hor PROP-04-0F Hodel Hor PROP-04-10

VD (Visual Merchandising) S.FOB Pricat S.FOB Prica £.FOB Prica:
Catalogue *

of Watel Tt Pulsar Windew Ttem: Pulsar Logo Itawrn: Pulsar
m Crisplay [com Stickar Presantation
Care of Watches with watch st Dimnension: &3 Tray

51 peos) : o] w360
b imangicn: 36,0 (w) = 2.9
| Erarwd Sizing Dirnension: Main - 44.0 [w) ¢¢u::;':l China (d) = 2.4 (h) e
Calibre information :;E'?h{]dt}r: Material: Sticker Country of Ching
Operating Manual Small x 2 - 24,6 UT: 1 month H;‘"‘:' s
it
Doverdosd Area tzfr:(f-gj ()= min Ondar Qtyr 2,000 pcs UTeemed -
B o [ ays
List of Distributors Coma with 51 pcs Min Crdar Qbyr 1,000 pes
Service Net ¥ watkch stand;
Country of Chine
Extranet ariging
Wirhsite Matariall Wood, Metal &
Acnglie

Change Password LT 50 days
| Hedp =

a Shows how (many) total pages and what page you are at.
e Click “Previous” to back to the previous page and “Next” to go to the next page.
a Click the picture for details.

0 Information of the product.
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o5 Abbreviation Page

”

" and then click “ Abbreviation

Click “Help
2} SEIED Mong Kong Ltd, - Microsoft Internet Explorer = I‘]I!I
£
- =
WO 3
Wobsio Edit | Details Edit | Details Edit | Details
Change Password
|Hen Tutorial
= =
roerom—t F i)
PFI2ITH1

TTE2 55 TTE2 55

55 55

MC 5B L MC 55 AD

PIOM2X G PR PZaEaM G

1008 PRE (=] 4 WR  PRE (=] 4

45005E3407TE80 450056541 0406

Edit | Details Edit | Details [Edit | Details

Page 1 of 11 Hext

]
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3  Abbreviation Page (cont.)

The Abbreviation page provides the detail description of the abbreviation of the feature table in
Image Library.

a SEIKO Hong Kong Ltd. - Microsoft Internet Explorer

Abbreviation
Group Field Ahbreviation Description
Head Case material 558 Stainless Steel case with Brass hezel

35F Stainless Steel case with Plastic Case
Tl Titanium case
BS Brass case
TIS Titanium case with Stainless steel hezel
55 Stainless Steel case
Case code GPHC Gold plated and Carbonized Titanium coated case 7 S5 back
GPDF SGP and POP case /55 back
THCSS Carbonized Titanium coated bezel, 58 case § 55 back
TGRTI PDF bezel, Titanium case f Titanium back
TGPDP PDP and SGP bezel, 35 case /55 back
FOP Palladium Plated case f 55 back
FGP Fink Gold Plated case f 55 hack
SGP Gold Plated case # 85 hack
55 Stainless Steel case f 55 back
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o3 Download Area

=101

|»

PULSAR

it’s all in the details

Admin Pages Pulsar « Lorus » Alba To view a Tutorial of this site click here

Home
Who We Are & History Download Area

Pulsar Today! Mission

Selling Features of Pulsar It is Download Area
Owver Competition

Selling Features of Pulsar
Watch It is item 1
Communication

Best Proposed Assortment » It is item1.tx=t
Image Library *

Logos *

Manufacturer's Brand
Brand Essence Film

YMD {Visual Merchandising)
Catalogue *

Glossary of Watches

Care of Watches

Band Sizing

Calibre Information

g Manua i
< Download Area

Service Hetwork
Extranet

=l
e

o5 Help

Help page provides support on user guide, Internet policy, Abbreviation, File formats and
Technical support.

@ Home

Click “Home” to back to the main page of the brand you're currently browsing.
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3 Change Password

1. Click “Change Password”.

23 SEIKD Hong Kong Lt ernet Explorer

Home
Who We Are & History
Pulsar Today! Mission

Selling Features of Pulsar
Over Competition

Selling Features of Pulsar
Watch

Communication
Best Proposed Assortment =
Image Library *»

:Jl_l T
’ L'n‘h'f s an

ebille
Logos » Wants six cl::lrlf?u iy gra ; .f..j ampnr € ¥ i
o Loves butterscoteh podding 5 TS SN BHHESE dhv
Matufactensvand Still usen & t;rpew!tl £, - ( !n."w"-"" <aanridoasilebuilder
Brand Essence Film e uf fren K S S, bl g
VMD (Visual Merchandising) !f,‘?;{:;r _ % ; : "-‘ ;::. : .:':;E:f
b il @

rn g oo b

Catalogue * o g e
Glossary of Watches - SULSAR ﬁ‘ = B “pu

Care of Watches L —— SO | ——
Band Sizing

Calibre Information

Operating Manual

Download Area

List of Distributors

Service Network pU LSAR

Extranet

Change Password

Copyright@®2005, SEIKS Hong Kang Ltd,

K
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o3 Change Password (cont.)

‘2 SEIKO Hong Kong Ltd. - Microsoft I iy =] B3
Change Password

User: admin

Old Password : ||_

MHew Password : |

Confirm Password : I_

Save I Cancel[

Enter old password in the “Old Password” field.

Enter new password in the “New Password” field.
Re-enter the new password in the “Confirm Password” field.
Click “Save” button to save the new password.

Click “Cancel” button for cancellation.

30

SEIKO Hong Kong Ltd.



SEIKO Hong Kong Ltd.

5™ FLOOR, YING TUNG INDUSTRIAL BUILDING, 802 LAl CHI KOK ROAD, KOWLOON,
HONG KONG
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